
Every now and then an improvement comes through in Excel that is truly newsworthy.  Here’s an item that many will be wanting!  I am talking about 
gaps in charts.

The #N/A error is produced when a formula can't find what it's been asked to look for.  It is also produced from the function =NA() which indicates 
no value is available.  With the following dataset, #N/A is currently shown in a line chart as a connecting line.  Microsoft has finally added the 
functionality for #N/A to be rendered as a blank:

Let me back up a little.  By default, data that is hidden in rows and 
columns in the worksheet is not displayed in a chart, and empty cells or 
null values are displayed as gaps.  For most chart types, you can display 
the hidden data in a chart.

For line, scatter, and radar chart types, you can also change the way that 
empty cells and cells that display the #N/A error are displayed in the 

chart.  Instead of displaying empty cells as gaps, you can display empty 
cells as zero values or you can span the gaps with a line.  For #N/A values, 
you can choose to display those as an empty cell or connect data points 
with a line.  The following examples show Excel’s behaviour with each of 
these options.

NEWSLETTER #60 - November 2017

It ’s a soft CELL this month as we continue with our A to Z of Excel Functions series.  
You might need a cup of CHAR afterwards… 

Get & Transform updates take a back seat this month as all seems to be quiet on this front, but Microsoft has been busy 
in other areas.  Power BI Desktop and Service have both been updated, and there’s good news too for users of charts and 
Mac books too.  There’s the usual features (Power BI Desktop Updates and Keyboard Shortcuts) and more news about new 
efficiencies in Excel and our travel plans too.

Until next month.

#N/A No Longer a Waste of Space
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Options for showing empty cells

OK, so this has been around for a while:
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Options for cells with #N/A

But this hasn’t!

To change the way that empty cells, null (#N/A) values and hidden rows and columns are displayed in a chart:

	 •	 Click the chart you want to change
	 •	Go to Chart Tools on the Ribbon, then on the ‘Design’ tab, in the ‘Data’ group, click ‘Select Data’:

	 •	 In the ‘Show empty cells as:’ options box, click ‘Gaps’, ‘Zero’, or ‘Connect data points with line’ as required
	 •	 It should be noted that on a scatter chart that displays only markers (without connecting lines), you can display empty cells as gaps or zero only 	
	 	 — you cannot connect the data points with a line
	 •	Click the Show #N/A as an empty cell’ option if you don’t want Excel to plot those points.

This feature is only available if you have an Office 365 subscription.  If you are an Office 365 subscriber, make sure you have the latest version of 
Office.  In order to maintain backwards compatibility with other versions of Excel, this feature is off by default.

	 •	 Click Hidden and Empty Cells:

You remember when you installed Office and the installation process asked you whether you wanted 
to submit telemetry back to Redmond?  Well, some of you said “yes” and as a consequence, Microsoft 
has been identifying some specific examples of slow, high CPU or out of memory performance issues.  
These have included:

	 •	 Slow copying and pasting of one column, in a sheet comprising of lots of rows of data with many 	
		  filtered
	 •	 Slow copying and pasting of many cells on a sheet with lots conditional formatting rules
	 •	 Slow performance or hanging when selecting cells after filtering or sorting rows from amongst 	
		  lots of rows of data in a sheet
	 •	High CPU opening a workbook with one or more sheets with lots of rows filtered, containing 		
		  merged cells and / or grouping
	 •	 Slow when creating, deleting and / or editing sheet names in a workbook with lots of 		
		  worksheets
	 •	High CPU and / or out of memory errors opening a workbook with lots of formulae (with full 		
		  column references (e.g. VLOOKUP over A:A) and / or multiple sheets
	 •	 Slow with deleting rows in a workbook with lots of formulae with full column references (e.g. A:A).

Excel Office 365 Performance Improvements
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So, if you thought it was just you – it isn’t.  Microsoft has been busy fixing these issues.  They have addressed each example above in the following 
ways:

	 •	While copying and pasting, Excel is now more intelligent in detecting the need to trigger time-consuming object searches before initiating them
	 •	While copying and pasting with conditional formatting (this is never a good thing!), the algorithm in Excel has now been “optimised” to consume  
		  time, proportional to the number of conditionally formatted cells involved
	 •	While selecting cells in the visible sheet, after an operation, Excel re-renders (or at least evaluates) all rows top to bottom (including filtered  
		  rows) in the visible sheet.  This may be expensive from a resource perspective, depending upon the number of rows and Excel’s ability to calculate  
		  for animation related rendering (do consider turning this option off).  This new optimisation caches prior rendered calculations for animation  
		  support and reduces time during each such calculation
	 •	While opening a workbook and rendering lots of rows with merged cells, Excel is now more intelligent in detecting the need to perform time- 
		  consuming merged cell rendering calculations before actually calculating
	 •	During sheet operations, the new fix ensures expensive sheet tab dimension calculations are performed optimally.  Time savings here augment  
		  VBA to perform bulk sheet operations faster too
	 •	While deleting rows that contain formulae with full column references, e.g. A:A, Excel optimises in bulk for all rows.  This saves memory 	
		  for such formulae and in turn reduces overhead for subsequent delete, edit and / or update operations involving them.  However, we still 	
		  strongly suggest never to have formulae reference an entire row or column.

These updates / optimisations / fixes apply to Excel O365 Version 16.0.8431.2058 or later updates, presently available to Office Insiders.  Microsoft 
invites feedback – good or bad – on these modifications at for a such as www.excel.uservoice.com.

Forms for Excel, powered by Microsoft Forms, has now replaced Excel Survey.  This update, available for Office 365 Commercial and Education 
customers only presently, makes it simple and easy to collect information from users in the same organisation, to anyone in the world. Forms for 
Excel includes new features such as response time, responder name, images, videos, themes, and branching logic.

There are various ways you can create a form:

	 •	OneDrive for Business: CLICK + New
	 •	Document library of modern SharePoint team sites (O365 group backed): CLICK + New
	 •	 Excel Online: Click Forms > + New Form.  The workbook is stored on OneDrive for Business or modern SharePoint team sites.

Introducing Forms for Excel
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You can build a form in your Excel workbook from Excel Online, OneDrive for Business, or SharePoint Online.

Whilst access to the forms may be limited, the forms themselves may be sent to anyone with the response data retained on OneDrive.

The results are available in real time, with charts available in Microsoft Forms and real-time response data readily available in your corresponding 
Excel workbook.
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As stated above, this is presently available for Office 365 Commercial and Education customers only.  It should also be noted that all existing Excel 
surveys you may have created will continue to work.  Further, you can still use Excel survey if "external sharing" is enabled for your classic SharePoint 
team sites.

As always, the main concerns users have with these sorts of features concerns privacy and security of data.  All data is primarily stored on servers 
of Microsoft Forms and all response data is automatically stored in your Excel workbook.  You can find out more about Security and Compliance 
for Microsoft Forms at support.office.com/en-us/article/Set-up-Microsoft-Forms-cc52287a-4550-464d-9a1b-457bf9df2240?ui=en-US&rs=en-
US&ad=US#ID0EAACAAA=Security_&_Compliance.

There's a major version update for Excel for Mac just been released (in Preview right now).  So far, it's just released to Insider Fast 
participants, but you can try it out by going to Help menu > Check for Updates and then opt into the Insiders program and choose 
'Insiders Fast'.  

Whilst there are finally some long-awaited improvements and 
features, Microsoft has been busy under the hood and has 
been updating the architecture of the product.  By the software 
company's own press release, it states that "...these early builds 
may be a little rough around the edges"!!  

For those with an Office 365 subscription in Excel, co-authoring 
and the dreaded AutoSave for OneDrive and SharePoint files are 
now available.  Changes are automatically saved as you work, 
and when you co-author with others, you can see their changes 
as they work in real-time.  There's also the charts which have 
been available for some time to PC users - namely the Waterfall, 
Funnel, Histogram, Pareto, Box & Whisker, TreeMap and Sunburst 
visualisations. 

If you don't have an Office 365 subscription, all is not lost.  Visual 
Basic for Applications (VBA) has been updated for everybody.  
Some additional methods, properties and objects available to 
Windows Office users will now work on Mac as well.  It's not 
perfect though.  There are still differences between the Mac and 
Windows Object Model, so you will still see "not supported on 
this platform"� for some elements.  

Welcome to the 20th century Mac users.  No doubt they'll put 
Excel in iTunes soon...

Excel for Mac gets a Makeover

The ability to refresh data easily is a useful feature of Power Query.  To begin with users are happy to carry this out manually by right clicking on an 
existing query.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.
com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month we thought it was time for 
refreshments…

Power Query Pointers
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As queries are added to and the Excel model becomes more complex, automated refreshing seems an attractive option.  There are several trigger 
points for refreshes, which require different methods to instigate them.  A query can be set to refresh when a workbook is opened or at a specified 
time interval, from the Excel menus.  These triggers can be extended to refresh Power Pivot too, since the refresh controls are held within the main 
Excel menus rather than as part of the Power Query (or Power Pivot) add-in.  

The refresh options for queries created in Power Query are found on the ‘Data’ tab in Excel – there is a ‘Connections’ section which features a 
‘Connections’ icon, clicking this brings up the ‘Workbook Connections’ screen.  The screen below shows the connections for the merged query 
created in September’s newsletter:

Having selected a query, you can look at the ‘Properties’ box, which includes a ‘Refresh Control’ section:
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There are several checkboxes:  
	 •	 Background refresh takes longer, but allow you to work whilst it’s in progress.  That’s why it is the default, and should only be taken off for 	
		  specific reasons as it will lock out users until complete
	 •	Refreshing every n minutes only works while the workbook is open.  It can be good for data that is frequently changing at source and can be 	
		  used in conjunction with the background refresh setting
	 •	Refreshing when opening the file does exactly what it suggests and can also be used in conjunction with the background refresh setting.  This 	
		  comes with an extra option to remove data from the external data range before saving the workbook; this option can be taken in order to  
		  save 	the workbook with the query definition but without the external data
	 •	Refresh this connection on ‘Refresh All’ ought to be checked as a general principle otherwise end users may believer data is up to date when it  
		  is not.

If these options are not enough, then there are some VBA options, but only use these if the queries are not going to be ported to Power BI.  A single 
connection or all connections can be refreshed on demand using VBA.  To refresh all connections some specific VBA code, so let’s look at simpler 
options here instead. 

A macro can be constructed to refresh a single connection on the ‘Developer’ tab when the workbook is open.  On the ‘Developer’ tab in the Excel 
Ribbon, there is an option to ‘Record Macro’.  Let’s call it ‘refresh’ and provide a description which states what is being refreshed:

Having set up the macro, you then perform the action you want to record, by refreshing the ACCT_Order_Charges_with_Group query from the 
‘Connections’ option on the ‘Data’ tab (say):
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Then, you may stop recording by going back to the ‘Developer’ tab and choosing to ‘Stop Recording’:

The macro may then be inspected.  From the Developer tab under Macros, editing shows the VBA behind it:

Whilst the refresh may be run from the macros section, it would be better to have a button. Still on the ‘Developer’ tab, in the ‘Control’ section, select 
‘Insert’ ‘Form Controls’ – hovering over the icons tells us what they are, and in this case, you can choose the button icon.  Once selected, the cursor 
turns into a ‘+’ so that the button may be positioned.  Having selected a location, you are then prompted for the macro that the button will run:
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Give it an appropriate name.  As long as you remember to save my workbook in .xlsm or .xlsb format (you will be warned if you try to save to .xlsx 
format), the button will be saved with the workbook, allowing you to refresh my connection without using the menus.

These options will be enough to get started with managing how connections are refreshed, but for the adventurous, more can be achieved by using 
third party add-ins, which can allow solutions to be ported to the web. 

Aside from being able to download Power BI Desktop for free from Power BI's website, you can now get it from the Microsoft Store 
too.  Now, that should be a good thing - or so it would seem.  But you can get too much of a good thing.  If you simply browse casually 
for Power BI be careful.  The Store "helpfully" only makes it third choice presently, as our graphic shows.  Many users are reporting 
that they are downloading the wrong application as a result.

To be fair, the apps are presented on a ranking system and Power BI Desktop is new so it won't be Number 1 in the search - yet.  The 
problem is, the current leader is the mobile app.  That's fair enough - IF this actually made it clearer it was the mobile variant.  You 
have been warned!

What's in Store for Power BI?

October sees another key feature from the Microsoft Data Insights Summit make its first appearance: bookmarking, albeit in Preview.  Combined 
with September's drillthrough feature, bookmarking provides powerful storytelling capabilities and highly interactive reporting.  There's also the 
usual visual improvements and a significant update for the quick measures feature.

In summary, here's the complete list of October updates:

October 2017 Updates for Power BI Desktop

Reporting

	 •	 Bookmarking (preview)
	 •	 Selection pane and visual display controls
	 •	Bookmark links for shapes and images (preview)

•	 Spotlight
•	 Scatter & bubble markers
•	 Increase the number of data points shown in scatter charts

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Analytics

	 •	Quick measures for SSAS live connections
	 •	 Sales from new customers quick measure
	 •	Cell-level formatting for multidimensional AS models

Data connectivity

	 •	Vertica connector (beta)
	 •	 SAP BW connector: support for additional member properties

Other

	 •	 Power BI Desktop in the Windows Store
	 •	 Improved access to help content.

Let’s take a look at each of these in turn.

Bookmarking (preview)

And so, bookmarking finally arrives!  This was one of the features demonstrated at the recent Data Insights Summit as a very powerful way to save 
and share out insights with others.  Bookmarking lets you save interesting states as part of your report.  Once you have a list of bookmarks, you can 
use those in several ways, including a quick way to pick up where you left off in your analysis, for organising presentations of your report, creating 
report navigation, etc.

When you add a bookmark to your report, it will include the following:
	 •	 the current page
	 •	filters
	 •	 slicers
	 •	 sort order
	 •	 drill location
	 •	Visibility (more on this later)
	 •	 any of the “focus” modes.

Microsoft even notes that although bookmark cross highlighting is not yet supported, this is on the radar and “…something we definitely plan to 
implement soon”.  That will be very cool.
Once you turn on the preview feature switch, you can add bookmarks by opening the bookmarks pane, which can be found under the ‘View’ tab:

You can set up your report to look how you want, with all the filters properly set, and click the ‘Add’ button under ‘Bookmarks’:
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This will add a bookmark to pane, which you can rename and go back to whenever you want. You can continue adding as many bookmarks as you want.

If you want to use your bookmarks as a story or in a presentation, you can use the ‘View’ option to enter into a view mode for bookmarks viz.

When in this mode, there is a title bar for each bookmark that includes the bookmark name and navigation arrows.  At this point, you can close the 
bookmarking pane if you want to.
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This mode is a good way to preview your bookmarks in the Power BI Desktop.  It’s also a great way to navigate bookmarks in the Power BI service 
(see below), where you can also enter into full screen mode to hide all the navigation menus.

While bookmarking is in preview, you will need to add your initial bookmarks to your report in the Power BI Desktop.  After you publish your reports 
to the service, you’ll see the bookmarks pane option in the ‘View’ dropdown and can then edit and view your bookmarks as you see fit.

Since this feature is in preview, you’ll need to enable it the first time through File>Options and Settings>Options.  In the dialog, open the ‘Preview 
features’ tab and select ‘Bookmarking’:

Selection pane and visual display controls

As part of the aforementioned bookmarking, Microsoft has also added a new selection pane. This pane lists out all objects on the report page you 
are currently viewing and allows you to select the visual from here.  This can be very useful when you are authoring complex reports with many 
overlapping charts.  You can also hide visuals on your report through this pane.  By combining this feature with bookmarking, you can create reports 
with visuals changing out depending on the current bookmark selection.

You can open the selection pane through the View’ tab:

In the selection pane, for each item on the current page, you’ll see either an eye or line icon letting you know if it is visible or not.  Clicking on the eye 
icon will let you toggle the visual between hidden and visible.
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As mentioned earlier, visibility state can also be bookmarked, so it is useful for storytelling purposes.  While hidden, slicers will continue to filter the 
report page, so you can continue to create reports using this feature.

Bookmark links for shapes and images (preview)

Another feature released in coordination with bookmarking is links for shapes and images.  Last month, as part of drillthrough, Microsoft added the 
ability to link shapes and images to the previous page to create back buttons.  This linking feature has now been extended to also allow you to link 
shapes and images to bookmarks as well.  This allows you to create custom navigation in your reports or creating buttons that perform different 
actions across your report.

You’ll find the option in the formatting pane under the ‘Link’ card.  You can pick either ‘Back’ or ‘Bookmark’ as your link type.  If you pick ‘Bookmark’, 
you’ll have a dropdown to pick one of the bookmarks you currently have in your report.

Spotlight

There’s more to bookmarking.  Microsoft has also added a new way to call attention to a specific chart during presentations.  You can already use 
the focus mode to temporarily increase the size of a chart to fill the whole page.  However, if you would prefer, you can now call attention to a chart 
without losing the context of the report instead.  You can spotlight a visual to fade out all the other charts on the page viz.

Just as with the back button, you can activate bookmark buttons by pressing CTRL + CLICK while in editing mode or simply by just clicking in reading 
mode.
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Clicking anywhere else on the report will remove the spotlight.  You can find this option under the “…” section of any chart.  

This spotlight feature can also be included as part of a bookmark.

You can also customise it per series to make your reports more accessible:

Scatter & bubble markers

Another feature released in coordination with bookmarking is links for shapes and images.  Last month, as part of drillthrough, Microsoft added the 
ability to link shapes and images to the previous page to create back buttons.  This linking feature has now been extended to also allow you to link 
shapes and images to bookmarks as well.  This allows you to create custom navigation in your reports or creating buttons that perform different 
actions across your report.

You’ll find the option in the formatting pane under the ‘Link’ card.  You can pick either ‘Back’ or ‘Bookmark’ as your link type.  If you pick ‘Bookmark’, 
you’ll have a dropdown to pick one of the bookmarks you currently have in your report.
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Increase the number of data points shown in scatter charts

September’s update introduced a new sampling algorithm for scatter charts designed with high density data in mind.  This is now built upon: 
Microsoft now allows you a way to increase the number of data points shown in your scatter chart.  Using the new Data volume slider in the ‘General’ 
card of the formatting pane, you can set the maximum data volume to any number between 3,500 and 10,000:

Sales from new customers quick measure

There’s another new quick measure: totals from new categories.  You’ll find this new quick measure under the ‘Filters’ category:

Quick measures for SSAS live connections

Now you can use quick measures for reporting that use a live connection 
mode against SQL Server Analysis Services (AS) models.  You can turn 
on this preview feature switch and start using them right away in 
your models.  One thing to be aware of though is since different quick 
measures require support for different DAX functions and operators, 
some quick measures won’t be available on certain AS server versions.

Microsoft has also extended quick measure support to work with custom 
date tables.  Previously, the time intelligent quick measures (period-to- 

 
date, period-over-period, rolling average) could only be used with the 
Power BI-provided hierarchies.  Now, if your model has a custom Date 
table (for example, the DimDate table in the AdventureWorks model), 
you can use the primary date column in that table for time intelligent 
quick measures.  This will only work though if you ensure that the person 
who built the model has marked it as a ‘Date table’.  That’s a significant 
improvement.

ust a friendly warning here.  Since more data points can mean a longer loading time, if you do choose to publish reports with limits at the higher 
end of the scale, make sure to test out your reports across the web and mobile as well make sure performance matches your users’ expectations.
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This quick measure lets you find things like the sales data for first time customers or the number of first time helpdesk callers.

Cell-level formatting for multidimensional AS models

If you have cell-level formatting set up in your on-premises SQL Server Analysis Services models, this will now be respected in your Power BI reports 
too.  You’ll see the formatting for your values in our table, matrix and single value card visuals, with no additional setup required.  Here’s an example 
Microsoft has provided from the AdventureWorks cube:

Vertica connector (beta)

With October’s update, a new data connector has also been added to 
Power BI Desktop for Vertica.  The Vertica Analytics platform is designed 
for use in data warehouses and other big data workloads where speed, 
scalability, simplicity and openness are crucial to the success of analytics.  
The new Vertica connector allows you to build reports by importing or  

 
creating a DirectQuery connection to your databases in the Vertica 
Analytics Platform.

The new Vertica connector is available as a beta connector and can be 
found under the “Other” category within the Get Data dialog:
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The first time you connect, you will be asked to specify credentials for Vertica.

Once the connection has been established with your credentials, you’ll be able to browse and select one or multiple tables within the Navigator 
dialog and then decide to load or edit your data.

When selecting this connector, you will be prompted to specify your Vertica server / database details and will be able to specify which Data 
Connectivity mode to use.
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SAP BW connector: support for additional member properties

One of the most requested features for the SAP BW connector has been the ability to import additional member properties, besides Medium Name.  
With this release of Power BI Desktop, other properties will now be available in the SAP BW connector so that you can select them within the 
Navigator dialog.

You can select one or multiple properties for each selected object, which will be represented as new columns in the output results of your queries.

Power BI Desktop in the Windows Store

As stated above, Power BI Desktop is now available from the Windows Store.  Until now, you could get Power BI Desktop by downloading it manually 
(from within the Power BI service, or from our download location) and install it directly – often referred to as an MSI installation.  With the new 
option of installing it from the Windows Store, you can take advantage of:
	 •	Automatic monthly updates installed in the background as soon as it's available
	 •	No longer needing admin privileges to install
	 •	 Smaller download size since the Windows Store makes sure that only the components that have changed in each update are downloaded to 	
		  your machine
	 •	 Easier IT deployments for everyone in your organization, including making Power BI Desktop available through the Microsoft Store for Business
	 •	Automatic language detection each time Power BI Desktop is launched

It’s just a shame it’s not the first thing you find in the Store when you search for it (see above)!

Improved access to help content

In order to make Power BI easier to follow (and to aid current users get access to community sites), this update sees a Help tab added.  This tab is all 
about giving you quick and easy access to all these resources.
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It's not just Power BI Desktop that's had a spruce up this month.  Microsoft has been busy and has also released additional features across Power BI 
Service and Mobile too.  In summary, here's the latest additions: 

	 •	 Share dashboards to free users with Premium
	 •	Allocate capacities to suit your business needs with v-core pooling
	 •	 Instantly scale-up or scale-down capacities with one click
	 •	 PubNub block to easily push data into REST APIs
	 •	Update for On-premises data gateway
	 •	 Filter reports on the go on Power BI Mobile
	 •	Cross platform Visio support
	 •	 Improved load performance for usage metrics.

I suppose we should go through each of these items too…

October 2017 Updates for Power BI Service

Share dashboards to free users with Premium

It goes without saying that Microsoft wants to make it as easy as possible 
for customers to adopt Premium for their existing Power BI deployments 
and start benefiting from unlimited distribution to all users, consistent 
performance, and increased scale.  While Power BI apps are the 
recommended approach for large scale distribution, some users want 
to utilise their existing dashboard sharing approach so they could adopt 
Premium more quickly.  As a result, the Service now allows dashboard 
sharing by Pro users of content in Premium workspaces to all users.

 
Apps continue to be the recommended way to distribute BI content to 
large groups of users and Microsoft encourages its customers to consider 
apps in their deployments.  Apps include features that make content 
distribution easy to manage including staging of changes, managing 
permissions for all reporting assets in one place, and a streamlined 
consumption experience for users. 

When Power BI Premium was first announced in June, it was required 
users had to choose between four different SKUs (EM3, P1, P2, P3), each 
which contained different numbers of virtual cores and memory sizes.  
This latest update sees released a set of features that give you much 
more flexibility on how you can allocate capacities and deploy Premium 
within your organisation.

The first feature is v-core pooling.  When users purchase a Premium SKU,  
they gain access to the corresponding number of v-cores.  For example,  

if you bought a P3, you will have access to 32 v-cores. By leveraging 
v-core pooling, you will have the flexibility to provision the v-cores into 
one or more nodes of Premium capacity.  With the same example, you 
can use your 32 v-cores to provision four P1s (4 nodes * 8 cores/node), 
two P2s (2 nodes * 16 cores/node), or just one P3.  You are also free to 
move between the different node configurations as long as you have the 
v-cores available.  And you thought it was all just hard core or soft core.

Allocate capacities to suit your business needs with v-core pooling

Instantly scale-up or scale-down capacities with one click

As part of the v-core pooling release, Microsoft is also making it easier to scale-up or scale-down your premium capacities with just one click.  For 
example, if you have a P1 node you can now scale that up to a P2 or P3 though the capacity admin portal, provided that you have purchased the 
required number of v-cores.  Conversely, you can scale down a capacity to a lower SKU to free up your already purchased v-cores for another node:
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PubNub block to easily push data into REST APIs

In partnership with PubNub, Microsoft has announced availability of a PubNub Block for easily pushing data into the Power BI REST APIs.  PubNub 
Blocks provide serverless functions which can be easily set up at a moment’s notice.  With the Power BI push dataset block, users can easily push data 
from PubNub streams to the Power BI REST APIs.  From there, the data can be visualised in real-time as a Power BI streaming dataset. 

Update for On-premises data gateway

There’s further enhancements in the new update for the Power BI On-premises data gateway.  The update includes Personal Mode support for 
national clouds, improved data gateway configuration experience when running Personal Mode and a new version of the Mashup Engine.  

Filter reports on the go on Power BI Mobile

At the beginning of this year, Microsoft introduced support for reports 
on mobile, which allowed authors to seamlessly create report views 
optimised for a phone’s form factor.  Starting from now, filters are now 
available on phone reports.

You can now gain full access to all the filtering capabilities available to 
you in the service on your phone with no further configuration needed.  
All the various levels including: report level, page level or visual level  

 
filters on the original report will automatically appear on your phone’s 
report in a touch optimised interface.

Just like on the Power BI Service, you can choose to use basic or advanced 
filtering, while having the default filtering set saved by the report author 
propagate to your mobile app.
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Cross platform Visio support

The Power BI team recently announced support for a new type of visualisations: Visio visualizations. This new feature allows you to create tailored 
charts without the need to code.  Once created and added to your report, all report viewers will be able to view and cross filter it across all platforms, 
including all mobile platforms.

Improved load performance for usage metrics

Also rolled out, there’s many performance enhancements and optimisations to usage metrics for reports and dashboards.  With this newest update, 
usage metrics reports now load more quickly, allowing dashboard and report authors to get even quicker insights into their impact. 

The road (air?) trip continues…  November sees us again all over Australia as well as in Hong Kong and Kuala Lumpur.  Drop us a line at 
contact@sumproduct.com if you’d like to meet up.  We’d be happy to discuss your modelling / training requirements.

We’re still not finished for 2017 though.  More to follow in our December issue.

We show off our new premises in Hong Kong…

Out and About in November

With our A to Z of Excel Functions series, you could argue we have been trying to make a soft CELL (get it?).  We are well and truly in the high C’s now 
and the puns do not get any better.  Ah well…

The CELL function returns information about the formatting, location, or contents of a cell. For example, if you want to verify that a cell contains a 
numeric value instead of text before you perform a calculation on it, you can use the following formula:

=IF(CELL("type", A1) = "v", A1 * 2, 0)

This formula calculates A1*2 only if cell A1 contains a numeric value, and returns 0 if A1 contains text or is blank.  The CELL function employs the 
following syntax to operate:

CELL(info_type, [reference])

The CELL function has the following arguments:

	 •	 info_type: this is required.  This is a text value that specifies what type of cell information you want to return.  The following list shows the 	
		  possible values of the info_type argument and the corresponding results:

The A to Z of Excel Functions: CELL
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	 •	 reference:  this is optional.  This is the cell that you want information about.   If this argument is omitted, the information specified in the 	
	 	 info_type argument is returned for the last cell that was changed.  If the reference argument is a range of cells, the CELL function returns the 	
	 	 information for only the upper left cell of the range.

CELL Format Codes

The following list describes the text values that the CELL function returns when the Info_type argument is "format" and the reference argument is a 
cell that is formatted with a built-in number format.
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Please see the example below: 

There’s lots you can do with CELL.  You may recall in one of our Thought articles we used it to automate the file name using the formula

=IF(ISERROR(OR(FIND("[",CELL("filename",A1)),FIND("]",CELL("filename",A1)))),"",MID(CELL("filename",A1),FIND("[",CELL("filename",A1))+1,FI
ND("]",CELL("filename",A1))-FIND("[",CELL("filename",A1))-1))

So how does this work?  

Let’s step back and consider the formula =CELL(“filename”,A1).  This returns the filename (any cell may be used).  An example of a returned filename 
might be:

C:\Documents and Settings\Liam\My Documents\Spreadsheet Doctor\Doctor 30 - Automated Filename\[Example Workbook.xls]Sheet1

This is not what is required, there’s ‘padding’.  All we want is the actual filename, in this case ‘Example Workbook.xls’.  Therefore, we need to extract 
the filename from this worksheet directory path.  

This will require a three-step process.

Step 1: FINDing the Beginning and the End

The directory path will vary for each file, so we need to spot a foolproof method of finding the beginning and the end of the workbook name.  
Fortunately, Excel assists us here.  ‘[’ and ‘]’ are reserved characters in Excel’s syntax and denote the beginning and the end of the workbook name.

The example returned filename above is 122 characters long.  If we can find the position of the ‘[’ and ‘]’ we will be on our way.

FIND(find_text,within_text,start_num) is the function we need, where:

	 •	find_text is the text you want to find;
	 •	within_text is the text containing the text you want to find; and
	 •	 start_num (which is optional) specifies the character at which to start the search. The first character in within_text is character number 1. If you  
		  omit start_num, it is assumed to be 1.

So, in our example, =FIND("[",CELL("filename",A1)) returns the value 95 and the formula =FIND("]",CELL("filename",A1)) returns the value 116.  In 
other words, for our illustration, if we can get Excel to return the character string in positions 96 to 115 inclusive (i.e. between the square brackets) 
we will have our workbook name.

Step 2: LEFT a bit, RIGHT a bit, Aim for the MID Section 

There are various functions in Excel that will return part of a character string:

	 •	 LEFT(text,num_characters) returns the first few characters of a string depending upon the number specified (num_characters).  This is not 	
		  useful here as we do not want the first few characters of our text string;
	 •	RIGHT(text,num_characters) returns the last few characters of a string depending upon the number specified (num_characters).  This is not 	
		  useful here either as we do not want the last few characters of our text string; and
	 •	MID(text,start_num,num_characters) returns a specific number of characters from a text string, starting at the position specified, based on the  
		  number of characters chosen.

Therefore, we should use the MID function here.  In hard code form, our formula would be:

=MID(CELL("filename",A1),96,20) 

where:

	 •	 96 = position one character to the right of ‘[’ (95 + 1); and 
	 •	 20 which is the length of the filename string, being the position of ‘]’ less the position of ‘[’ less 1, i.e. 116 – 95 – 1 = 20.  

This gives us our filename ‘Example Workbook.xls’.

The problem is we don’t want hard code: a flexible formula is required.  Using the concepts explained above, we derive:

=MID(CELL("filename",A1),FIND("[",CELL("filename",A1))+1,FIND("]",CELL("filename",A1))-FIND("[",CELL("filename",A1))-1)

And so we are done.  Except we aren’t.
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Step 3: Error Trapping  

A good modeller will always ensure that a formula will work in all foreseeable circumstances.  The above formula will only work if the file has been 
named and saved.  Otherwise, CELL("filename",A1) will return empty text (“”), which will cause the embedded FIND formulae to return #VALUE! 
errors, and hence the overall formula will also return the #VALUE! error.

We therefore need an error trap, i.e. a check that ensures if the file has not yet been saved we just get empty text (“”) returned.  To do this, we can 
use the following formula:

=IF(ISERROR(OR(FIND("[",CELL("filename",A1)),FIND("]",CELL("filename",A1)))),"",1)

ISERROR(expression) gives a value of TRUE if the expression is evaluated as an error, otherwise it is FALSE.  In our equation above, if the file has not 
been saved, this formula will return the empty text (“”), otherwise it will return our ‘dummy’ value of 1.  Substituting our derived formula above for 
the 1 gives us the final formula:

=IF(ISERROR(OR(FIND("[",CELL("filename",A1)),FIND("]",CELL("filename",A1)))),"",MID(CELL("filename",A1),FIND("[",CELL("filename",A1))+1,FI
ND("]",CELL("filename",A1))-FIND("[",CELL("filename",A1))-1))

It isn’t pretty, it’s not short, it’s not transparent, but it’s flexible and robust.

Cup of tea?  Well a cup of CHAR won’t help you…

This function returns the character specified by a number.  You can use CHAR to translate code page numbers you might get from files on other types 
of computers into characters.  Yup, that exciting.

The CHAR function employs the following syntax to operate:

CHAR(number)

The CHAR function has the following arguments:

	 •	number: this is required.  This is a number between 1 and 255 specifying which character you want.  The character is from the character set used  
		  by your computer.

Again, please see the example below: 

More next month.

The A to Z of Excel Functions: CHAR

Upcoming SumProduct Training Courses
Location Course Date Duration

Sydney Visual Basic for Applications 6th Nov 2017 1 day

Sydney Excel Tips & Tricks 13th Nov 2017 1 day

Sydney Financial Modelling 14th - 15th Nov 2017 2 days

Melbourne Power Pivot, Power Query and Power BI 4th - 6th Dec 2017 3 days

Melbourne Excel Tips & Tricks 11th Dec 2017 1 day

Melbourne Financial Modelling 12th - 13th Dec 2017 2 days

Sydney Excel Tips & Tricks 15th Jan 2018 1 day

Sydney Financial Modelling 16th - 17th Jan 2018 2 days

Sydney Power Pivot, Power Query and Power BI 22nd - 24th Jan 2018 3 days

Melbourne Power Pivot, Power Query and Power BI 29th - 31st Jan 2018 3 days

Hobart Financial Modelling 5th - 6th Feb 2018 2 days

Melbourne Power Pivot, Power Query and Power BI 4th - 6th Dec 2017 3 days

Brisbane Excel Tips & Tricks 12th Feb 2018 1 days

Brisbane Financial Modelling 13th - 14th Feb 2018 2 days
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Sydney Address:	 SumProduct Pty Ltd, Suite 52, Level 10, 88 Pitt Street, Sydney, NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Level 9, 440 Collins Street, Melbourne, VIC 3000
Registered Address:	SumProduct Pty Ltd, Level 6, 468 St Kilda Road, Melbourne, VIC 3004

Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month we’re amidst the 
numbers 7, 8 and 9:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Keystroke What it does

CTRL + 7 Sort of defunct now, toggled Standard toolbar in Excel 2003 and earlier

CTRL + SHIFT + 7 Outline border

CTRL + 8 Show outline symbols (toggle)

CTRL + SHIFT + 8 Select current region (this may not work on keyboards with a number pad)

CTRL + 9 Hide row

CTRL + SHIFT + 9 Unhide row

Have you heard about the 
SumProduct Referral programme? 
If you successfully introduce us to a 
client we will pay you 10% of the net 
profits of the engagement won upon 
receipt of client payment. Sounds like 
a pretty good deal to us!

Terms and conditions apply.  Referrer 
must be over 18 years of age, able 
to issue an invoice and not be an 
employee, director, agent or other 
related party of the client engaged.  
For further information, drop us a line 
at  contact@sumproduct.com.  We 
hope to hear from you!

Referral Programme

Melbourne Excel Tips & Tricks 19th Feb 2018 1 day

Melbourne Financial Modelling 20th - 21st Feb 2018 2 days

Perth Financial Modelling 26th - 27th Feb 2018 2 days 

Sydney Visual Basic for Applications 12th Mar 2018 1 day

Sydney Power Pivot, Power Query and Power BI 19th - 21st Mar 2018 3 days

Adelaide Financial Modelling 5th - 6th Apr 2018 2 days 

Sydney Excel Tips & Tricks 23rd Apr 2018 1 day

Sydney Financial Modelling 26th - 27th Apr 2018 2 days

Melbourne Excel Tips & Tricks 30th Apr 2018 1 day

Melbourne Financial Modelling 1st - 2nd May 2018 2 day

Melbourne Power Pivot, Power Query and Power BI 14th - 16th May 2018 2 day

Auckland Financial Modelling 21st - 22nd May 2018 2 days

Wellington Financial Modelling 24th - 25th May 2018 2 days

Darwin Financial Modelling 4th - 5th Jun 2018 2 days

Sydney Power Pivot, Power Query and Power BI 18th - 20th Jun 2018 1 day 

Sydney Financial Modelling 25th - 26th Jun 2018 2 days
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